From which menu you can insert Header and Footer?

A. Insert Menu

B. View Menu

C. Format menu

D. Tools Menu

Correct Answer: A

To get to the ‘Symbol’ dialog box, click on the menu and choose ‘Symbol’.

A. Insert

B. Format

C. Tools

D. Table

Correct Answer: A

. option from clipboard is used to move data from one place to another.in a document.
A. Copy & Paste

B. Cut & Paste

C. Bold

D. Justify

Correct Answer: B

. is an option in Font Group.
A.Strikethrough

B.Find

C.Replace

D. Change Styles

Correct Answer: A

. Name the button in the picture?
A.Font Color

B.Fill Color

C.Page Color

D.Highlighter tool

Correct Answer: D

. Shortcut for document.views toolbar is situated in bar.
A.Task bar

B.Status bar

C.Tool bar.

D.Title bar

Correct Answer: B

. Bullets and'Numbering is in tab.
A.Home tab

B.Insert tab

C.Pagelayout tab

D.View tab

Correct Answer: A

. Toopen a existing document, click on the and then select Open.

A.MS Office button

B.Quick Access Toolbar

C.Document Views

D.Ribbon

Correct Answer: A

. Cut, Copy and Paste is in Group in the Home tab.
A.Font



10.

B.Page Setup
C.Clipboard
D.Editing
Correct Answer: C
is used to covert from upper case to lower case and vice versa.
A.Toggle case
B.Sentence case
C.Lower case
D.Upper case
Correct Answer: A
11.
Pressing F8 key for three times selects
A) A word
B) A sentence
C) A paragraph
D) Entire document
Correct Answer: B
12.
What is the shortcut key you can press to create a copyright symbol?
A) Alt+Ctrl+C
B) Alt+C
C)Ctrl+C
D) Ctrl + Shift + C
Correct Answer: A
13.
What is the smallest and largest font'size available in‘Font Size tool on formatting toolbar?
A) 8and 72
B) 8 and 64
C)12and 72
D) None of above
Correct Answer: A
14.
Which of the following.is graphics'solution for Word Processors?
A) Clipart
B) WordArt
C) Drop Cap
D)All of above
Correct Answer: A
15.
The keystrokes Cirl + | is used to
A) Increasefont size
B) Inserts a line break
C) Indicate the text should be bold
D) Applies italic format to selected text
Correct Answer: D
16.
A character that is raised and smaller above the baseline is known as
A) Outlined
B) Raised
C) Superscript



D) Subscript

Correct Answer: C

17.

Thesaurus tool in MS Word is used for

A) Spelling suggestions

B) Grammar options

C) Synonyms and Antonyms words

D) All of above

Correct Answer: C

18.

Why Drop Caps are used in document?

A) To drop all the capital letters

B) To automatically begin each paragraph with capital letter
C) To begin a paragraph with a large dropped initial capital letter
D) None of above

Correct Answer: C

19.

A bookmark is an item or location in document that you identify as a name for future reference. Which
of the following task is accomplished by using bookmarks?
A) To add anchors in web page

B) To mark the ending of a paragraph of document

C) To quickly jump to specific location in document

D) To add hyperlinks in webpage

Correct Answer: C

20.

Which of the following is not valid version of MS Office?
A)

Office XP

B) Office Vista

C) Office 2007

D) None of above

Correct Answer:B

21.

You cannot'close MS Word application by

A) Choosing File menu then Exit submenu

B) Press Alt+F4

C)Click X button on title bar

D) From File menu.choose Close submenu

Correct Answer: D

22.

The key F12 opens a

A) Save As dialog box

B) Open dialog box

C) Save dialog box

D) Close dialog box

Correct Answer: A

23.

What is the short cut key to open the Open dialog box?
A) F12

B) Shift F12



C) Alt +F12

D) Ctrl + F12

Correct Answer: D

24.

. A feature of MS Word that saves the document automatically after certain interval is available on
A) Save tab on Options dialog box

B) Save As dialog box

C) Both of above

D) None of above

Correct Answer: A

25.

Which of the following is not available on the Ruler of MS Word screen?
A) Tab stop box

B) Left Indent

C) Right Indent

D) Center Indent

E) All of them are available on ruler

Correct Answer: D

26.

Which file starts MS Word?

A) Winword.exe

B) Word.exe

C) Msword.exe

D) Word2003.exe

Correct Answer: A

217.

If you want to keep track of different editions of a document which features will you use?
A) Editions

B) Versions

C) Track Change

D) All of above

Correct Answer:B

28.

Background color or effects applied on a document is not visible in
A) Web layout view

B) Print Layoutview

C)Reading View

D) Print Preview

Correct Answer: D

29.

What is a portion of a document in which you set certain page formatting options?
A) Page

B) Document

C) Section

D) Page Setup

Correct Answer: C

30.

Borders can be applied to

A) Cells

B) Paragraph



C) Text

D) All of above

Correct Answer: D

31.

Which of the following is not a type of page margin?
A) Left

B) Right

C) Center

D) Top

Correct Answer: C

32.

What is the default left margin in Word 2003 document?
A) 1"

B) 1.25"

C) 15"

D) 2"

Correct Answer: B

33.

Portrait and Landscape are

A) Page Orientation

B) Paper Size

C) Page Layout

D) All of above

Correct Answer: A

34.

If you need to change the typeface of a document, which.menu will you choose?
A) Edit

B) View

C) Format

D) Tools

Correct Answer: C

35.

Which of the following.is not a font style?

A) Bold

B) Italics

C) Regular

D) Superscript

Correct Answer: D

36.

What happenswhen you click on Insert >> Picture >> Clip Art
A) It inserts‘a clipart picture into document

B) It lets you choose clipart to insert into document
C) It opens Clip Art taskbar

D) None of above

Correct Answer: C

37.

Which option is not available in Insert Table Autofit behavior?
A) Fixed Column Width

B) AutoFit to Contents

C) Autofit to Window



D) Autofit to Column

Correct Answer: D

38.

To autofit the width of column

A) Double click the right border of column

B) Double click the left border of column

C) Double click the column header

D) All of above

Correct Answer: A

39.

Which of the following statement is false?

A) You can set different header footer for even and odd pages

B) You can set different page number formats for different sections
C) You can set different header footer for first page of a section

D) You can set different header and footer for last page of a section
Correct Answer: D

40.

Where can you change the vertical alignment?

A) Formatting toolbar

B) Paragraph dialog box

C) Page Setup dialog box

D) Standard toolbar

Correct Answer: C

41.

AutoCorrect was originally designed;to replace words as you type.
A) Short, repetitive

B) Grammatically incorrect

C) Misspelled

D) None of the above

Correct Answer: C

42.

Which of the following is the second step in creating a macro?

A) Start recording

B) Using your mouse or keyboard, perform the task you want to automate
C) Assign a keyboard shortcut to the macro

D) Give the macro a name
Correct Answer: C

43.

In'Word, the mailing list is known as the
A) Data sheet

B) Source

C) Data source

D) Sheet

Correct Answer: C

44,

Which of the following is not one of the three ‘Mail Merge Helper’ steps?
A) Merge the two files

B) Create the main document

C) Set the mailing list parameters

D) Create the data source




Correct Answer: C

45.

Which of the following button will allow you to add, delete, or change records in your Data Source?
A) ‘Data Source’ button

B) ‘Edit’ button

C) ‘Edit Data Source’ button

D) ‘Data editing’ button

Correct Answer: C

46.

It is possible to a data source before performing a merge.
A) Create

B) Modify

C) Sort

D) all of the above

Correct Answer: D

47.

Comments can be added to cells using .....
A. Edit -> Comments

B. Insert -> Comment

C. File -> Comments

D. View —> Comments

Correct Answer: B

48.

Which of the following is not a valid Zoom percentage in Excel?
A) 10

B) 100

C) 300

D) 500

Correct Answer: D

49,

The spelling tool is.placed on toolbar
A) Standard

B) Formatting

C) Drawing

D) Reviewing

Correct Answer: A

50:

Which of the following is not a valid data type in Excel?
A. Number

B. Character

C. Label

D. Date/Time

Correct Answer: B

51.

Comments put in cells are called .....

A. Smart Tip

B. Cell Tip

C. Web Tip

D. Soft Tip

Correct Answer: B



52.

Which menu option can be used to split windows into two?
A. Format -> Window

B. View -> Window-> Split

C. Window -> Split

D. View —> Split

Correct Answer: C

53.

You can activate a cell by

a. Pressing the Tab key

b. Clicking the cell

c. Pressing an arrow key

d. All of above

Correct Answer: D

54.

When you use the fill effects in the format data series dialog box, you can not
a. rotate text on the chart

b. select a fore ground color

c. select a pattern

d. select a background color

Correct Answer: A

55.

To insert three columns between columns D-and E you would
a. Select column D

b. Select column E

c. Select columns E, F and G

d. Select columns D, E, and F.

Correct Answer: B

56.

Hyperlinks cannot be

a. Special shapes like stars and banners

b. Drawing objects like rectangles ovals

c. Pictures

d. All can be hyperlinks

Correct Answer: D

57.

You can add an image to a template by clicking the Insert Picture From File button on the
a. Standard

b. Formatting

c. Drawing

d. Picture

Correct Answer: D

58.

To drag a selected range of data to another worksheet in the same workbook, use the
a. Tab key

b. Alt key

c. Shift key

d. Ctrl key

Correct Answer: D

59.

.... Toolbar.



When you print preview a worksheet

a. the entire worksheet is displayed

b. the selected range is displayed

c. the active portion of the worksheet is displayed

d.a,bandc

Correct Answer: D

60.

You can open the Sort dialog box by choosing Sort from the ..... menu

a. View

b. Format

c. Tools

d. Data

Correct Answer: D

61.

When working in the page break preview, you can

a. view exactly where each page break occurs

b. add or remove page breaks

c. change the print area

d. all of above

Correct Answer: D

62.

Which of the following is not a valid Zoom percentage in Excel? A) 10 B) 100 C) 300 D) 500 Correct
Answer: D

63.

The spelling tool is placed on toolbar A) Standard B) Formatting C) Drawing D) Reviewing
Correct Answer: A

64.Formatting a cell in Currency, you can specify A) Decimal Places B) Currency Symbol C) Both of
above

D) None of above Correct/Answer: C

64.

Formatting a cell indNumber format you can’t set A) Decimal Places B) Use 1000 separator C) Negative
numbers D) Currency Symbol

Correct Answer: D

65.

What is entered by the function =today() A) The date value for the day according to system clock B)
The time value according to system clock C) Today’s date as Text format D) All of above Correct
Answer: A

66.

Which-function will you use to enter current time in a woksheet cell? A) =today() B) =now() C) =time()
D) =currentTime()

Correct Answer: B

67.

Merge cells option can be applied from A) Format Cells dialog box Alignment Tab B) Formatting
toolbar C) Both of above D) None of above Correct Answer: A

68.

Which of the following format you can decide to apply or not in AutoFormat dialog box? A) Number
format B) Border format C) Font format D) All of above Correct Answer: D

69.

How can you remove borders applied in cells? A) Choose None on Border tab of Format cells B) Open
the list on Border tool in Formatting toolbar then choose first tool (no border) C) Both of above D) None



of above

Correct Answer: C

70.

You can set Page Border in Excel from A) From Border tab in Format Cells dialog box B) From Border
tool in Formatting toolbar C) From Line Style tool in Drawing toolbar D) You can not set page border in
Excel Correct Answer: D

71.

You can check the conditions against when applying conditional formatting A) Cell value
B) Formula

C) Both of above D) None of above Correct Answer: C

72.

When a range is selected, how can you activate the previous cell? A) Press the Alt key B) Press Tab C)
Press Enter D) None of above

Correct Answer: D

73.

Each excel file is a workbook that contains different sheets. Which of the following can not be a sheet in
workbook? A) work sheet B) chart sheet C) module sheet D) data sheet Correct Answer: D

74.

Which of the following Excel screen components can NOT be turned.on or off? A) Formula Bar B)
Status Bar C) Tool Bar D) None of above Correct Answer: D

75.

Which of the following option is not available in Paste Special dialog box?

A) Add B) Subtract C) Divide D) SQRT

Correct Answer: D

76.

Which of the cell pointer indicates that you can fill series? A) Doctor’s symbol (Big Plus) B) small thin
plus icon C) Mouse Pointer with anchor at.the tip D) None of above

Correct Answer: C

77.

Which of the following'is an absolute cell.reference?

a. 'All

b. $A$1

C. #a#l

d. Al

Correct Answer: b

78.

Which symbol must all formula begin with?

a.=

b.+

c. (

d @

Correct Answer: a

79.

Which of the following formulas is not entered correctly?

a. =10+50

b. =B7*B1

c.=B7+14

d. 10+50

Correct Answer: d

80.



Which of the following formulas will Excel Not be able to calculate?
a. =SUM(Sales)-A3

b. =SUM(AL1:A5)*.5

c. =SUM(A1:A5)/(10-10)

d. =SUM(A1:A5)-10

Correct Answer: a

81.

A worksheet range is a

a. A command used for data modeling

b. A range of values such as from 23 to 234

c. A group of cells

d. A group of worksheets

Correct Answer: ¢

82.

The auto calculate feature

a. Can only add values in a range of cells

b. Provides a quick way to view the result of an arithmetic operation on arange of cells
c. Automatically creates formulas and adds them to a worksheet
d.Aandc

Correct Answer: b

83.

Excel uniquely identifies cells within a worksheet.with a cell name
a. Cell names

b. Column numbers and row letters

c. Column letters and row numbers

d. Cell locator coordinates

Correct Answer: ¢

84.

To drag a selected range of data.to another worksheet in the same workbook, use the
a. Tab key

b. Alt key

c. Shift key

d. Ctrl key

Correct Answer: D

85.

Hyperlinks cande

a. Text

b. Drawing.objects

c. Pictures

d. All of above

Correct Answer: d

86.

To activate the previous cell in a pre-selected range, press

a. The Alt key

b. The Tab key

c. The Enter key

d. None of the above

Correct Answer: d

87.

Which button do yu click to add up a series of numbers?



a. The autosum button

b. The Formula button

c. The quicktotal button

d. The total button

Correct Answer: a

88.

When the formula bar is active, you can see
a. The edit formula button

b. The cancel button

c. The enter button

d. All of the above

Correct Answer: d

89.

In a worksheet you can select

a. The entire worksheet

b. Rows

c. Columns

d. All of the above

Correct Answer: b

90.

Which area in an excel window allows entering values and formulas
a. Title bar

b. Menu bar

c. Formula bar

d. Standard toolbar

Correct Answer: ¢

91.

To edit in an embedded excel worksheet object in a word document
a. Use the excel menu barandteolbars inside the word application
b. Edit the hyperlink

c. Edit the data in a.excel source application
d. Use the word menu bar and toolbars
Correct Answer: a

92.

To create a formula, you canwuse:

a. Values but not cell references

b..C ell references but not values

¢. Values.or cell references although not both at the same time
d. Value and cellreferences

Correct: Answer: d

93.

Status indicators are located on the

a. Vertical scroll bar

b. Horizontal scroll bar

c. Formula bar

d. Standard toolbar

Correct Answer: ¢

94,

An excel workbook is a collection of

a. Workbooks



b. Worksheets

c. Charts

d. Worksheets and charts

Correct Answer: d

95,

Excel files have a default extension of

a. Xls

b. Xlw

c. WK1

d. 123

Correct Answer: a

96.

Except for the ...... function, a formula with a logical function shows the word “TRUE” or “FALSE” as
a result

a. IF

b. AND

c. OR

d. NOT

Correct Answer: a

97.

Macros are “run” or executed from the ..... menu.
a. Insert

b. Frmat

c. Tools

d. Data

Correct Answer: ¢

98.

You can open the consolidate dialog box byt choosing Consolidate from the ..... menu.
a. Insert

b. Format

c. Tools

d. Data

Correct Answer: d

99.

How are/data organized in a spreadsheet?

a. Lines and spaces

b.Layers and planes

¢. Rows and columns

d. Height and width

Correct Answer: ¢

100.

Gridlines

a. May.be turned off for display but turned on for printing
b. May be turned on or off for printing

c. The be turned off for display and printing
d.a,bandc

Correct Answer: d

101.

A function inside another function is called a ..... function.
a. Nested



b. Round

c. Sum

d. Text

Correct Answer: a

102.

Which function calculates your monthly mortage payment?
a. PMT (payments)

b. NPER (number of periods)

c. PV (present value)

d. All of above

Correct Answer: a

103.

To drag a selected range of data to another worksheet in the same workbook, use the
a. Tab key

b. Alt key

c. Shift key

d. Ctrl key

Correct Answer: d

104.

When the formula bar is activated, you can see
a. The Edit Formula button

b. The Cancel button

c. The Enter button

d. All of above

Correct Answer: d

105.

Which file format can be added to a PowerPoint show?
a. .Jpg

b. .giv

C. .wav

d. All of the above

Correct Answer;d

106.

Material consisting of text.and numbers is best presented as
a. A table slide

b. A bullet slide

c. Atitle slide

d. All of the above

Correct Answer: a

107.

In order toedit a chart, you can

a. Triple click the chart object

b. Click and drag the chart object

c. Double click the chart object

d. Click the chart object

Correct Answer: ¢

108.

to exit the PowerPoint

a. click the application minimize button

b. click the document close button



c. double click the applications control menu icon

d. double click the document control menu icon

Correct Answer: ¢

109.

To select one hyperlink after another during a slide presentation, what do you press?
a. Tab

b. Ctrl + K

c.Ctrl + h

d. All of above

Correct Answer: a

110.

special effects used to introduce slides in a presentation are called

a. effects

b. custom animations

c. transitions

d. present animations

Correct Answer: ¢

111.

What is the term used when you press and hold the left mouse key and more the mouse around the slide?
a. Highlighting

b. Dragging

c. Selecting

d. Moving

Correct Answer: b

112.

To give a PowerPoint presentation to a large audience, you:

a. Set up your computer in a large auditorium, and click large, auditorium, OK
b. Click the slide you wish the audience to see in normal view, then click the next slide, and so on.
c. Choose either view, slide show or slide show, view show

d. Slick slide show, OK

Correct Answer: ¢

113.

Which of the following.can you use to add times to the slides in a presentation
a. Slice Show menu

b. Rehearse timing button

c. Slide transition button

d. All of the above

Correct Answer: b

114.

Which of the following is not one of PowerPoint’s views?

a. Slide show view

b. Slide view

c. Presentation view

d. Outline view

Correct Answer: ¢

115.

Which PowerPoint view works best for adding slide transitions?

a. Slide show view

b. Slide sorter view

c. Slide view



d. Notes view

Correct Answer: b

116.

Which of the following views is the best view to use when setting transition effects for all slides in a
presentation

a. Slide sorter view

b. Notes page view

c. Slide view

d. Outline view

Correct Answer: a

117.

Which option can be used to set custom timings for slides in a presentation?
a. Slider Timings

b. Slider Timer

c. Rehearsal

d. Slide Show Setup

Correct Answer: ¢

118.

Which of the following will not advance the slides in a slide show view?
a. The esc key

b. The space bar

c. The enter key

d. The mouse button

Correct Answer: a

119.

The quickest way to create a PowerPoint presentation is:to use the

a. Word for windows templates

b. Auto creation wizard

c. Auto content wizard

d. Presentation wizard

Correct Answer: ¢

120.

Which opf the following can you format using buttons on the formatting toolbar?
a. Your hard drive

b. Format painting

c. Font color

d..Underlining

Correct Answer: d

121.

To start Microsoft PowerPoint application

A) Click on‘Start >> Programs >> All Programs >> Microsoft PowerPoint
B) Hit Ctrl + R then type ppoint.exe and Enter

C) Click Start >> Run then type powerpnt then press Enter

D) All'of above

Correct Answer:C

122.

Which menu provides you options like Animation Scheme, custom Animation, Slide Transition?
A) Insert Menu

B) Format Menu

C) Tools Menu



D) Slide Show Menu

Correct Answer: d

123.

In which menu can you find features like Slide Design, Slide Layout etc.?
A) Insert Menu

B) Format Menu

C) Tools Menu

D) Slide Show Menu

Correct Answer: B

124.

The selected design template can be applied

A) To current slide only

B) To all the slides

C) To all the new presentation you create

D) All of above

Correct Answer: D

125.

What feature will you use to apply motion effects in between a slide exits and another enters?
A) Slide Transition

B) Slide Design

C) Animation Objects

D) Animation Scheme

Correct Answer: A

126.

What PowerPoint feature will you use to apply motion effects to different objects of a slide?
A) Slide Transition

B) Slide Design

C) Animation Objects

D) Animation Scheme

Correct Answer: D

127.

Which commandwill you use in PowerPoint if you need to change the color of different objects without
changing content?

A) Design Template

B) Color/Scheme

C) Font Color

D)Object Color

Correct Answer: B

128.

Which short cut key inserts a new slide in current presentation?
A) Ctrl+N

B) Ctrl+M

C) Ctrl+S

D) All'of above

Correct Answer: B

129.

To start slide show of a presentation

A) Hit F5 key

B) From Slide Show menu choose View Show option

C) From Slide Show menu choose Rehearse timing



D)Botha &b

Correct Answer: D

130.

If you select Insert >> Picture >> From File

A) You can insert pictures and clipArts

B) You can insert clipArts only

C) You can insert pictures only

D) None of above

Correct Answer: C

131.

Which of the following font effect is not available in PowerPoint Font dialogox?
A) Underline

B) Shadow

C) Emboss

D) Strikethrough

Correct Answer: D

132.

To insert a hyperlink in a slide

A) Choose Insert >> Hyperlink

B) Press Ctrl + K

C) Hyperlinks can’t be inserted in slides

D)Botha &b

Correct Answer: D

133.

In a PowerPoint presentation

A) Sound clips can be inserted but nat movie.clips

B) Movie clips can be inserted but not sound clips

C) Both cannot be inserted

D) Both can be inserted

Correct Answer: D

134.

To insert slide numbers

A) Insert a text box and select Insert >> Page Number

B) Insert a textbox and select Insert >> Number >> PageNumber
C) Choose Insert >> Slide Number

D) Insert'a new-text box andselect Insert >> slide Number
Correct Answer: D

135.

What are the three options available in Insert >> Picture menu?
A) Clipart, Pictures, Shapes

B) Clipart, From File, Shapes

C) Clipart, From Files, AutoShapes

D) Clipart, Pictures, AutoShapes

Correct Answer: C

136.

From which menu you can access Picture, Test Box, Chart etc?
A) File

B) Edit

C) Insert

D) View



Correct Answer: C

137.

Which of the following is not a part of Slide Design?

A) Design Template

B) Color Scheme

C) Animation Scheme

D) Slide Layout

Correct Answer: D

138.

What is the term used when a clip art image changes the direction of faces?
a. Group

b. Flip

c. Rotate

d. All of the above

Correct Answer: ¢

139.

the slide that is used to introduce a topic and set the tone for the presentation is called the
a. table slide

b. graph slide

c. bullet slide

d. title slide

Correct Answer: d

140.

Which of the following features should you use when typing in the notes text box?
a. Slide show

b. Insert

c. Slide maser

d. Zoom

Correct Answer: d

141.

Which command brings you. to the first slide in your presentation?

a. Next slide button

b. Page up

c. Ctrl + Home

d. Ctrl + End

Correct Answer: ¢

142.

You can show the shortcut menu during the slide show by

a. Clicking the shartcut button on the formatting toolbar

b. Right.clicking the current slide

¢. Clicking.an icon on the current slide

d.aand b

Correct Answer: b

143.

Auto clipart is a feature that

a. Automatically places clipart in your presentation

b. Scans your presentation for incorrect spelling in your words on each slide
c. Scans your presentation for incorrect spelling in Word Arts objects
d. All of above

Correct Answer: d



144.

The view that displays the slides on a presentation as miniature representations of the slides is called
a. slide show

b. slide sorter view

C. notes page view

d. outline view

Correct Answer: b

145.

Which of the following provides a printed copy of your presentation?
a. Outline

b. Speaker notes

c. Audience handouts

d. All of the above

Correct Answer: ¢

146.

When using PowerPoint, to play a PowerPoint show for previewing'the show, select
a. View, slide sorter

b. View, slide

c. View, slide show

d. View outline

Correct Answer: ¢

147.

To select all the boxes of an organization chart

a. Click edit, select all

b. Right click the chart background click select all

c. Press and hold the shift key and click.each.box

d. All of the above

Correct Answer: d

148.

Which of the following should e used when you want to add a slide to an existing presentation?
a. File, add a new slide

b. Insert, new slide

c. File, open

d. File, new

Correct Answer: b

149.

Which key deletes text before, or the left of, the insertion point?
a. Backspace

b. Page up

c. Delete

d. Page down

Correct Answer: a

150.

Microsoft PowerPoint is a

a. Database program

b. Spreadsheet program

c. Presentation program

d. Word processing program

Correct Answer: ¢

151.



Which of the following programs is not a popular desktop publishing program?
a) Adobe PageMaker

b) Microsoft Publisher

c¢) Lotus AmiPro

d) QuarkXPress

Answer: C

152.

Which menu provides you options like Animation Scheme, custom Animation, Slide Transition?
A) Insert Menu

B) Format Menu

C) Tools Menu

D) Slide Show Menu

Correct Answer: D

153.

In which menu can you find features like Slide Design, Slide Layout etc.?
A) Insert Menu

B) Format Menu

C) Tools Menu

D) Slide Show Menu

Correct Answer: B

154.

Which of the following is not a font style?

A) Bold

B) Italics

C) Regular

D) Superscript

Correct Answer: D

155.

Which of the following ismnot atype of page margin?

A) Left

B) Right

C) Center

D) Top

Correct Answer: C

156.

Whats a portion of adocument in which you set certain page formatting options?
A) Page

B) Document

C) Section

D) Page Setup

Correct Answer: C

157.

Background color or effects applied on a document is not visible in
A) Web layout view

B) Print Layout view

C) Reading View

D) Print Preview

Correct Answer: D

158.

Which of the following is not true about Find and Replace in Excel



A) You can search for bold and replace with italics

B) You can decide whether to look for the whole word or not
C) You can search in formula too

D) You can search by rows or columns or sheets Correct Answer: D
159.

The best way to insert a new slide in a presentation is to use the
a. Normal view

b. Special view

c. Slide show view

d. Slide sorter view

Correct Answer: d

160.

What is the maximum number of lines you can set for a drop cap?
A)3

B) 10

C) 15

D) 20

Correct Answer: B

161.

Which of the following line spacing is invalid?

A) Single

B) Double

C) Triple

D) Multiple

Correct Answer: C

162.

Which of the following are word processing software?

A) WordPerfect

B) Easy Word

C) MS Word

D) All of above

Correct Answer:.D

163.

Which of the following is.not of the merge process?

A) Sort the data source records

B) Format a main document

C)Edit a data source

D) Mergethe two files to print or create a new document
Correct Answer: A

164.

Which of the following is the latest version of MS Word?

A) Word 2000

B) Word 2007

C) Word 2010

D) Word 2011

Correct Answer: C

165.

In Microsoft PowerPoint two kind of sound effects files that can be added to the presentation are
a. .wav files and .mid files

b. .wav files and .qgif files



c. .wav files and .jpg files

d. .jpg files and .gif files

Correct Answer: a

166.

special effects used to introduce slides in a presentation are called
a. effects

b. custom animations

c. transitions

d. present animations

Correct Answer: ¢

167.

In Microsoft PowerPoint the entry effect as one slide replaces another in a show is called a (an)
a. animation

b. slide transition

C. custom animation

d. preset animation

Correct Answer: b

168.

To add a header or footer to your handout, you can use
a. The title master

b. The slide master

c. The handout master

d. All of above

Correct Answer: ¢

169.

In Microsoft PowerPoint in order to ‘see.all the slides on.one screen use
a. view, slide sorter

b. view, slide

c. view, master

d. view, slide show

Correct Answer: a

170.

77.Which of the following is the default page setup orientation for slides in PowerPoint?
a. Vertical

b. Landscape

c. Portrait

d..None of above

Correct Answer: b

171.

Pagemaker is.a software.

A.

Desktop Publishing

B.

Word Processor

C.

Spredsheet

D.

Presentation

Correct Answer:A

172.



is at the top of the window and it display the name of the application.
A
Menu bar
B.
Title bar
C.
Tool bar
D.
Tool box
Correct Answer:B
173.

is displayed below the title bar
A.
Menu bar
B.
Title bar
C.
Tool bar
D.
Tool box
Correct Answer:A
174.
Layout is in
A

Menu bar
B.
Title bar
C.
Tool bar
D.
Tool box

Correct Answer;

175.

Save optio resent r.

A.

176.

The tool used to select any kind of object on the page is called
A.

Rotate tool

B.

Text tool

C.



Pointer tool
D.
Crop tool
Correct Answer:C
177.
contains all the toolswe need to compose a page.
A.
Menu bar
B.
Title bar
C.
Tool bar
D.
Tool box
Correct Answer:D
178.
Clicking on the tool changes the pointer to an insertion point for typing and highlighting text.
A
Rotate tool
B.
Text tool
C.
Pointer tool
D.
Crop tool
Correct Answer:B
179.
tool rotates a text box orimage to a desired angle.
A.
Rotate tool
B.
Text tool
C.
Rotate tool
D.
Crop.tool
Correct Answer:C
180.
tool is used to reduce or cut image area.
A.
Rotate tool
B.
Text tool
C.
Rotate tool
D.
Crop tool
Correct Answer:D
181.
tool is used to draw square cornered boxes.



A.

Rotate tool
B.

Text tool
C.

Box tool
D

Crop tool
Correct Answer:C
182.
The tool used to move the entire page on the screen is called .
A
Hand tool
B.
Text tool
C.
Box tool
D.
Crop tool
Correct Answer:A ’
183.
tool is used to change the magnificatio evi
A
Hand tool
B.
Text tool
C.
Zoom tool
D

Crop tool

Correct Answer:C
184.

Colors Palette
A.
Menu b

enu.




D.

Narrow

Correct Answer:A
186.

The style is draw a verticle line through the middle of each word is called

A
Reverse
B.
Strike thru
C.
Italic
D.
Normal
Correct Answer:B
187.

Is the line between two lines of type.
A
Leading
B.
Tracking
C.
Formatting
D.
Editing
Correct Answer:A
188.
Adjusting the space between two consecutive characters is called
A.
Leading
B.
Tracking
C.
Formatting
D.
Editing
Correct Answer:B
189.
Paragraphformating options are present in menu.
A
Menu bar
B.
Title bar
C.
Tool bar
D.
Type menu
Correct Answer:D
190.

move the text inward from right and left margins.

A



Indent

B.

Cut

C.

Spacing

D.
Formatting

Correct Answer:A

191.

Which is not an alignment option in Page maker?

A

Align Left

B.

Justified

C.

Center

D.

Bottom

Correct Answer:D

192. ’
Cut option is present in menu.
A

Menu bar

B.
Edit menur

C.

Tool bar

D.

Type menu
Correct Answer:B
193.
Remove pages IS Us menu.
A.
Layout m

is used to specify both color and type of fill and line in one operation.
A.
Fill and stroke
B.

Fill

C.

Insert page

D.



Force Justify
Correct Answer:A
195.
means changing font size.
A.
Leading
B

Tracking
C.
Scaling
D.
Editing
Correct Answer:C
196.

button inserted in slides will perform predefined action n you cl on
A

Action

B.

Find

c g
Justify

D.

View

Correct Answer:A
197.

In Excel 2007, there are __ works orkb

OgrROWIN >

Correct er:B
198.

ab nsisting of rows and columns.

ok
D.
Range
Correct Answer:A
199.
The numeric data entered in the worksheet is aligned by default.
A.
Left



B.

Right

C.

Center

D.

Top

Correct Answer:B
200.

To insert a chart to excel, click on tab.
A.

Insert

B.

Home

C.

Formulas

D.

View

Correct Answer:A




